Oracle® Hyperion Financial Data Quality Management, Fusion Edition

Oracle Hyperion® Financial Data Quality Management for Hyperion Enterprise
Oracle® Hyperion Financial Data Quality Management Adapter Suite
Oracle® Hyperion Financial Data Quality Management ERP Source Adapter for SAP
Oracle® Hyperion Financial Data Quality Management for Oracle Hyperion Enterprise Planning Suite

Configuration Guide

RELEASE 11.1.2.1
## Contents

### Chapter 1. FDM Overview
- Prerequisites .......................................................... 7
- New Installations and Maintenance Releases ......................... 7
- FDM Components ..................................................... 8
  - Web Server ........................................................ 8
  - Task Manager ...................................................... 8
  - Application Server .................................................. 9
  - Load Balance Manager ............................................... 9
  - Workbench Client .................................................. 9

### Chapter 2. Configuration Overview
- Server Configurations .................................................. 11
  - Web Server ....................................................... 11
  - Application Server ................................................. 11
  - Load Balance Server ................................................ 12
  - Workbench Client ................................................. 12
- Other Configurations .................................................. 12
  - Settings Specific to Oracle ............................................ 12
  - Settings Specific to SQL Server ......................................... 12
  - Integrating with the Target Application ................................. 13

### Chapter 3. Configuring Web Server Components
- Verifying that ASP.NET is Enabled (Windows 2003 Server Only) ........... 15
- Specifying the Windows Account .......................................... 15
- Modifying Microsoft .NET Timeout Settings ............................... 16

### Chapter 4. Configuring Task Manager ............................................ 19

### Chapter 5. Configuring Application Server Components .............................. 21

### Chapter 6. Configuring Load Balance Manager ............................................. 23
- About Load Balance Manager ............................................... 23
- Specifying the Windows Account and Adding Application Servers ............. 23
<table>
<thead>
<tr>
<th>Chapter 7. Configuring Workbench</th>
<th>29</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8. Setting Up FDM Applications</td>
<td>31</td>
</tr>
<tr>
<td>Creating FDM Applications</td>
<td>31</td>
</tr>
<tr>
<td>Configuring FDM for Oracle</td>
<td>33</td>
</tr>
<tr>
<td>Single-Width and Double-Width Equivalents in Oracle DB</td>
<td>34</td>
</tr>
<tr>
<td>Configuring FDM for SQL Server</td>
<td>34</td>
</tr>
<tr>
<td>Importing Standard Reports</td>
<td>34</td>
</tr>
<tr>
<td>Copying Standard Templates</td>
<td>35</td>
</tr>
<tr>
<td>Integration Requirements</td>
<td>35</td>
</tr>
<tr>
<td>Chapter 9. Configuring Adapters</td>
<td>37</td>
</tr>
<tr>
<td>About Adapters</td>
<td>37</td>
</tr>
<tr>
<td>DLL/EXE</td>
<td>37</td>
</tr>
<tr>
<td>XML Metadata</td>
<td>37</td>
</tr>
<tr>
<td>Dimensions</td>
<td>38</td>
</tr>
<tr>
<td>Actions</td>
<td>38</td>
</tr>
<tr>
<td>Machine Profile</td>
<td>38</td>
</tr>
<tr>
<td>Options</td>
<td>38</td>
</tr>
<tr>
<td>About Integration with Target Applications</td>
<td>38</td>
</tr>
<tr>
<td>Integrating with Target Applications</td>
<td>39</td>
</tr>
<tr>
<td>Logging on to FDM applications</td>
<td>39</td>
</tr>
<tr>
<td>Importing Target System and Source System Adapters</td>
<td>40</td>
</tr>
<tr>
<td>Adding Machine Profiles</td>
<td>40</td>
</tr>
<tr>
<td>Updating DCOM Settings (Hyperion Enterprise and Essbase only)</td>
<td>40</td>
</tr>
<tr>
<td>Mapping FDM Dimensions to Target Dimensions (Financial Management and Essbase only)</td>
<td>41</td>
</tr>
<tr>
<td>Logging on FDM Applications by Using the Web Client</td>
<td>42</td>
</tr>
<tr>
<td>Verifying Application Settings</td>
<td>42</td>
</tr>
<tr>
<td>Updating Integration Settings</td>
<td>43</td>
</tr>
<tr>
<td>Testing the Integration Settings</td>
<td>43</td>
</tr>
<tr>
<td>Copying Adapters</td>
<td>45</td>
</tr>
<tr>
<td>Chapter 10. Upgrading FDM</td>
<td>47</td>
</tr>
<tr>
<td>Updating Schemas</td>
<td>48</td>
</tr>
<tr>
<td>Migrating Users to Shared Services</td>
<td>49</td>
</tr>
<tr>
<td>Troubleshooting Provisioning</td>
<td>50</td>
</tr>
<tr>
<td>Updating Scripts</td>
<td>51</td>
</tr>
</tbody>
</table>
Chapter 11. Multilanguage Support ................................................................. 53
  Regional and Browser Settings ................................................................. 53
  Changing Preferences .................................................................................. 55
    Decimal Replace on Database Setup ......................................................... 56
    Date Formatting on Midtier Items .............................................................. 57
    Non-English User Settings ....................................................................... 57
    Schema Updater Logs .............................................................................. 57
    Multibyte-Compatible Font Names in Report Designer ......................... 57

Appendix A. System Recommendations ....................................................... 59
  Database Server ......................................................................................... 59
    Recommended Hardware ........................................................................... 59
    Database Sizing ....................................................................................... 59
  Application Server Recommended Hardware ........................................... 60
  Web Server ................................................................................................ 60
    Recommended Hardware ........................................................................... 60
    .NET Process Configuration ................................................................... 60
    Memory Recycling .................................................................................. 60
  Application Settings .................................................................................. 61
  Firewall/DCOM Settings ........................................................................... 61
  TCP Keep Alive Settings ........................................................................... 61
FDM Overview

In This Chapter

- Prerequisites................................................................................................. 7
- New Installations and Maintenance Releases............................................................ 7
- FDM Components........................................................................................... 8

Prerequisites


New Installations and Maintenance Releases

Perform the steps in the following table for new installations and when applying maintenance releases. When applying an upgrade, see Table 2, “FDM Upgrade Checklist,” on page 47.

Table 1  FDM Installation and Maintenance Release Checklist

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
</table>
| 1    | Perform Oracle Hyperion Enterprise Performance Management System installation prerequisites | See the Oracle Hyperion Enterprise Performance Management Installation and Configuration Guide and the Oracle Hyperion Enterprise Performance Management System Installation and Configuration Readme. Review both documents thoroughly before installing FDM or ERP Integrator. Refer to the following checklists in the Oracle Hyperion Enterprise Performance Management System Installation and Configuration Guide:  
  - Installation Checklist—For a first-time installation of FDM  
  - Maintenance Release Installation Checklist—when applying a maintenance release to FDM |
| 2    | Install FDM using EPM System Installer | See the Oracle Hyperion Enterprise Performance Management Installation and Configuration Guide for installation procedures. |
| 3    | Configure FDM using EPM System Configurator | Configure FDM using EPM System Configurator. EPM System Configurator registers FDM with Oracle's Hyperion® Shared Services and creates the FDM Task Manager Service and FDM virtual directory in IIS. Procedures are included in the Oracle Hyperion Enterprise Performance Management System Installation and Configuration Guide. |
### FDM Components

The FDM installation consists of five components:

- Web Server
- Task Manager
- Application Server
- Load Balance Manager
- Workbench Client

### Web Server

The Web-based interface provides access to most FDM features and can be used by end users and administrators. On the Web server, a virtual Web directory and various FDM components are installed.

### Task Manager

Task Manager installs a Windows service that runs scheduled tasks (FDM scripts) at specified intervals. Tasks can be scheduled to run repeatedly, daily, weekly, or monthly. Task Manager
can be installed on any server that can access the FDM application (the Web server, the application server, or the data server where FDM data resides).

**Application Server**

The Application Server component enables the execution of resource-intensive tasks on a server other than the Web server, and thus can be used to limit database and file system access to a server behind a firewall (when the Web server is in front of the firewall).

**Load Balance Manager**

The Load Balance Manager component is responsible for two tasks—to load-balance the FDM application servers and to store the FDM application configuration. Usually, an installation places the Load Balance Manager component on one computer that is running the Application Server component and a backup Load Balance Manager component on another application server.

**Workbench Client**

Workbench is a Windows client application that serves as an administration and development environment. Here, you can perform common administrator maintenance tasks for scripts, adapters, and reports.
In This Chapter

Server Configurations...................................................................................... 11
Other Configurations....................................................................................... 12

Server Configurations

The following must be configured after installing FDM:

- Web Server
- Application Server
- Load Balance Server
- Workbench Client

Web Server

The FDM Web server account is entered in Web Config Manager.

Application Server

- The integration adapter is downloaded and copied to the FDM Adapters directory (example: <Oracle Home>/Middleware/EPMSYSTEM11R1/products/FinancialDataQuality/Adapters).

  **Note:** When unzipping the adapters to the Adapters directory, be sure to maintain the folder structure included in the adapter ZIP file.

  **Note:** You must create the Adapters directory if it does not exist.

- The FDM Application Server account that is specified during pre-installation is entered in Application Server Config Manager. The FDM Application Server and Web Server accounts must be the same.

- The adapter that was copied to the FDM application server is registered (use the Register Adapter option from within FDM Workbench).
Load Balance Server

This section applies to the Load Balance Manager (installation on an FDM application server) and the optional backup Load Balance Manager (installation on another FDM application server).

- The FDM Application Server account that is specified during pre-installation (same account as the FDM Web Server account) is entered in Load Balance Config Manager.
- The FDM Application Servers on which Application Server component was installed are added in the Application Servers tab.
- All authentication providers that FDM uses when authenticating users are added and configured in the Authentication Providers tab.

Workbench Client

The Workbench is installed on any PC or on the load-balance server using a remote session.

- The Load Balance server group, default load balance servers, and backup load balance servers (optional) are added using Workbench client.
- Adapters are registered using the Workbench client. See the adapter readme for your specific adapter for information regarding adapter registration.

Other Configurations

The following sections contain information about system-specific settings.

Settings Specific to Oracle

In the Database tab, select OLE DB Provider: ORACLEDDB.ORACLE, and then enter the service name for the new Oracle connection.

- If you do not select Use Integrated Security, specify the FDM Oracle User/Schema specified in pre-installation.
- When you access FDM from the Web, select Use Integrated Security. The FDM Application Server account is used to log on to the Oracle database. When you access FDM from Workbench, the logon name used to log on to Workbench is used to log on to the Oracle database.

Settings Specific to SQL Server

On the Database tab, enter the database server name and the name for the new SQL database.

- If you do not select Use Integrated Security, specify the FDM SQLOLEDB (SQL Server OLE DB), FDM SQLNCLI (SQL Server 2005 Native Client), or FDM SQLNCLI10 (SQL 2008 and 2008 R2) account specified during pre-installation.
When you access FDM from the Web, select Use Integrated Security. The FDM Application Server account is used to log on to the SQL Server database. When you access FDM from Workbench, the logon name used to log on to Workbench is used to log on to the SQL Server database.

**Note:** If SQLNCLI is used, Microsoft SQL Server Native Client (2005 or 2008) is required on all FDM application servers, load-balance servers, and any computer where FDM Workbench is installed.

**Integrating with the Target Application**

Detailed instructions on installation and setup of integration adapters is included in Chapter 9, “Configuring Adapters.”

**Note:** When using Oracle Hyperion Financial Management, Fusion Edition; Oracle Essbase; Oracle Hyperion Planning, Fusion Edition; or Oracle’s Hyperion® Enterprise® as target systems, the target system clients must be installed on the same server as FDM.
In This Chapter

Verifying that ASP.NET is Enabled (Windows 2003 Server Only) .............................................. 15
Specifying the Windows Account ......................................................................... 15
Modifying Microsoft .NET Timeout Settings .............................................................. 16

This section applies only if the FDM Web Server components are installed.

Verifying that ASP.NET is Enabled (Windows 2003 Server Only)

➢ To enable ASP.NET:
1. From Windows Control Panel, select Add/Remove Programs.
2. Select Add/Remove Windows Components.
3. Select Application Server, and click Details.
4. Verify that ASP.NET is selected.

Specifying the Windows Account

The FDM Web Server components use the Microsoft .NET Framework. Therefore, you must specify the Windows account under which the .NET process will run. The FDM DCOM objects also use this account. The account can be a local or domain account. The alternative to granting the permissions listed below is to make the account a member of the local administrators group, though this is less secure. For detailed information on what access the specified Windows account requires for the .NET Framework, refer to the following Web page:


If the specified account does not have administrator rights, on the Web server, the account must have at least full control permission for the following folders and subfolders:

- //Program Files/Microsoft Visual Studio .NET 2003
- //WINNT/Microsoft .NET
The Windows account must also have full control permission on the FDM application folders that reside on the data server.

To specify the Windows account:

2. On the General tab of the Web Config Manager, enter the Windows account user name, password, and domain for the .NET Web process to run under.

   The account information is stored in the IIS metabase.

   Note: Oracle recommends against running IIS in Isolation mode.

3. Select the Load Balance Server tab, and specify the load balance server.

   The load balance server is the computer that stores FDM application configurations and performs load balancing on FDM application servers. You may also specify a backup load balance server. If a backup is specified when you create, modify, add, or remove a FDM application, the application configuration file is copied from the load balance server to the backup load balance server.

4. Restart IIS by opening a command prompt and typing IISReset.

Modifying Microsoft .NET Timeout Settings

If an FDM process requires more than 60 minutes, the client browser session stops because the Microsoft .NET session times out. Executing a large Hyperion consolidation or uploading and processing a large multiperiod source file are two examples of FDM processes that may require more than 60 minutes. You can modify the timeout settings by modifying Web.config and Machine.config.

On the Web server, Web.config is located in this directory:

- `<Oracle Home>/Middleware/EPMSyste11R1/products/FinancialDataQuality/WebServerComponents/Web site`

The machine.config file is located in the following directory on the Web server:

- `//Windows/Microsoft.NET/Framework/v2.0.50727/CONFIG`

To increase the timeout setting (example to change timeout setting from 60 minutes to 120 minutes):

1. In Web.config, change “60” to “120” in the following line:

   ```xml
   <forms name=".HyperionFDM" loginUrl="Pages/Login.aspx" protection="All" timeout="60" path="/">
   ```
2 In Web.config, change "60" to "120" in the following line:

```xml
<sessionState mode="InProc" stateConnectionString="tcpip=127.0.0.1:42424" sqlConnectionString="data source=127.0.0.1;user id=sa;password=" cookieless="false" timeout="60"/>
```

3 In Web.config, change “3600” to “7200” in the following line:

```xml
<httpRuntime executionTimeout="3600" maxRequestLength="25600"/>
```

4 In Machine.config, change "00:60:00" to "02:00:00" in the following line:

```xml
<processModel enable="true" timeout="Infinite"
idleTimeout="Infinite" shutdownTimeout="0:00:05"
restartQueueLimit="1000" memoryLimit="30" WebGarden="false"
cpuMask="0xffffffff" userName="machine" password="AutoGenerate"
logLevel="Errors" clientConnectedCheck="0:00:05"
comAuthenticationLevel="Connect" comImpersonationLevel="Impersonate"
responseDeadlockInterval="00:60:00" maxWorkerThreads="100"
maxIoThreads="100"/>
```

5 In IIS Manager, increase the connection timeout setting of the default Web site, for example, change 3600 seconds to 7200 seconds.
Configuring Task Manager

Task Manager installs a Windows service that runs scheduled tasks (FDM scripts) at specified intervals. Tasks can be scheduled to run daily, weekly, or monthly. Task Manager can be installed on any server that can access the FDM application (the Web server, the application server, or the data server on which FDM data resides).

Task Manager consists of a Windows service and a Windows client program. You must specify the Windows account under which the Task Manager service and the FDM DCOM objects run. The Windows account must have full control permission for the FDM application folders that reside on the data server and rights to the target system.

To configure Task Manager:

1. Launch Task Manager Configuration by selecting Start > Programs > Oracle EPM System > Financial Data Quality Management Task Manager > Task Manager Configuration.

2. On the General tab of Task Manager Configuration, enter the Windows account user name, password, and domain under which the Windows service will run.

3. Click OK.

   If the FDM Task Manager service is running, you must restart the service for the changes to take effect.

4. Select the Load Balancer Server tab, and specify the load balance server.

   The load balance server is the computer that stores the FDM application configuration and performs load balancing on FDM application servers. You can specify a backup load balance server. If a backup server is specified, when you create, modify, add, or remove a FDM application, the application configuration file is copied from the load balance server to the backup load balance server.

5. On the local machine, select Start > Programs > Administrative Tools > Local Security Policy

   The Local Security Settings window is displayed. Because the Windows account is used to run a Windows service, it must have the “Log on as a service” user right.
6 In the Security Settings pane (left), expand Local Policies, and select User Rights Assignment.

7 In the right pane, double-click Log on as a service.

8 Click OK.

Note: If the local computer is part of a Windows domain and the domain controller defines the “Log on as a service” user right, you must modify the security settings on the domain controller, in Domain Control Security.
Configuring Application Server Components

The Application Server component enables the execution of resource-intensive tasks on a server other than the Web server, and thus can be used to limit database and file system access to a server behind a firewall (when the Web server is in front of the firewall).

After installing the Application Server component, you must specify the Windows account under which the application server DCOM objects run. The Windows account must have full control permission on the FDM application folders that reside on the data server and rights to the target system.

To configure application servers:

1. Launch Application Server Config Manager by selecting Start > Programs > Oracle EPM System > Financial Data Quality Management > Application Server > Application Server Config Manager.

2. Enter the Windows account user name, password, and domain under which you want the application server to run.

3. Click OK.
In This Chapter

About Load Balance Manager ................................................................. 23
Specifying the Windows Account and Adding Application Servers .......... 23

About Load Balance Manager

Load Balance Manager is responsible for balancing the load on the FDM application servers and storing the FDM application configuration. A common scenario is to install Load Balance Manager on a computer that is running the Application Server component.

Specifying the Windows Account and Adding Application Servers

After installing Load Balance Manager, you must specify the Windows account under which the Load Balance Manager DCOM objects run. The Windows account must have full control permission on the FDM application folders that reside on the data server and rights to the target system.

You must also add FDM application servers and authentication providers.

To configure Load Balance Manager:

1 From the Windows Start menu, select Programs > Oracle EPM System > Financial Data Quality Management > Load Balance Manager > Load Balance Configuration to launch the load balance configuration.

2 On the General tab, enter the Windows account user name, password, and domain under which Load Balance Manager will run.

3 Select the Application Servers tab, and add all servers that are running the FDM Application Server component.

You can designate a server by domain name, IP address, or computer name.

4 Select the Authentication Providers tab, and then add the authentication providers that will participate in FDM.

This screen enables you to add VBScript (Visual Basic Script), SSO Script (Single Sign-on script), and CSS (Common Shared Services) as authentication providers.
**Note:** The SSO Script option is used when integrating with non-Shared Services applications. When integrating with products that use Shared Services use the CSS option.

**Note:** Custom scripts do not support multibyte or extended ASCII characters in the script name or in the script parameters.

You can specify any combination of the available authentication providers. FDM attempts to authenticate the users by using the authentication providers in the order in which they are listed, from top to bottom. You can use the Move Up and Move Down buttons to change the order. At least one enabled authentication provider is required.

### Adding Visual Basic Script Authentication Providers

**Note:** Use the following procedure when running FDM without Shared Services.

1. To add Visual Basic Script authentication providers:
   1. On the Authentication Providers tab, click Add.
      
      For item descriptions, hover the mouse over an information icon.
As needed, perform these actions:

- **Description**—Enter a description for the provider.
- **Visual Basic Script**—Enter the Visual Basic script that will perform authentication.
- **Enabled**—Check this option to force FDM to use the Visual Basic script as the authentication provider. There must be at least one enabled authentication provider.

Test the authentication:

a. Click **Logon Test**.

b. On the Logon Test dialog box, enter a user name, password, and domain name.

c. Click **OK**.

To add Visual Basic script SSO authentication providers:

1. **On the Authentication Providers tab, click Add.**

2. **On the Add Authentication Providers screen, select Visual Basic Script SSO Authentication.**

The following dialog box is displayed. To the right of each item is an information icon. Hovering the mouse over an icon displays a description of the item.
3 As needed, perform these actions:

a. **Description**—Enter a description for the provider.

b. **Visual Basic Script**—Enter the Visual Basic script that will perform single sign-on authentication.

c. **Enabled**—Check this option to force FDM to use Visual Basic Script SSO as an authentication provider.

Because SSO authentication does not apply to the FDM Workbench client, at least one authentication provider must be enabled (other than the Visual Basic script SSO authentication).

### Enabling Shared Services

**Note:** Except when integrating with Hyperion Enterprise and using script-based authentication, Shared Services is required.

Use the FDM Load Balance Manager to enable FDM to use Shared Services.
To enable FDM to use Shared Services:


2. On the Hyperion FDM Load Balance Manager Configuration Screen, select the Authentication Providers tab.

3. Click Add.


5. On the Authentication Provider screen, click OK.

6. In Description, enter a description for the authentication provider.

7. In App Creation Group, enter the name of the user group (optional).

8. Enter a user name and password in the corresponding fields.

   The user must have administrative privileges in Shared Services.

9. Click Test Connection to verify the user.

10. Click OK to close the connection verification message.

11. Click OK to close the Authentication Provider screen.

12. On the Hyperion FDM Load Balance Manager screen, click OK.
Configuring Workbench

Workbench is a Windows client program that serves as an administration and development environment. It enables you to perform common administrator maintenance tasks for integration adapters, scripts, and reports.

After installing Workbench, you must specify the computer that is running FDM Load Balance Manager. This computer stores FDM application information and performs load balancing on FDM application servers.

To configure Workbench:

   
   **Note:** You must have local administrator rights on the computer where Workbench is installed.

2. Click Add.

   
   A domain name, IP address, or server name are all acceptable formats in which to designate the server. You can browse for a server by clicking.

4. Optional: specify a backup load balancer server.
   
   If a backup server is specified, when you create, modify, add, or remove an FDM application, the application configuration file is copied from the load balance server to the backup load balance server.

5. Click OK to return to the Load Balance Server Group dialog box.

6. Click Connect to attach to the selected load balance server group.
After the FDM software is installed and configured, create an FDM application. The FDM application is usually created on a data server (the same server that the target system’s data is located).

**Creating FDM Applications**

Open the Web browser, and enter the following URL:

http://<WebServerName>/HyperionFDM

**Note:** If you are using a nonstandard port number for IIS, you must include the port number in the aforementioned URL.

You can also create FDM applications by launching the FDM Workbench.

1. Select *<New Application>* and enter an authenticated user account.
   
   This account is the default FDM Administrator account.

2. In the *General* tab, enter the new FDM application name and path to the FDM application and the application group name in the *App Group* field.

**Note:** The App Group field is visible only when Shared Services is the selected authentication provider.

To create FDM applications:

1. Navigate to the FDM Logon page by typing the following URL into the browser: http://<WebServerName>/HyperionFDM/
2 From Application, select <New Application> and click Logon.

3 Enter the user name, password, and domain of an account that can create FDM applications.

   See “About Load Balance Manager” on page 23 for details on specifying authentication providers. The specified account is added to the FDM application as a FDM administrator.

4 On the General tab in the New Application form, enter the name, description, path, and application group of the new application.

   Note: The App Group field (for entering the application group name) is visible only when Shared Services is selected as the authentication provider.

If users access the application from multiple Web and application servers, Oracle recommends that you use the UNC naming convention to avoid problems with inconsistent drive letter mapping.

   Note: It is highly recommended to create the FDM application on the data server. When FDM imports GL data into the system, it uses a highly efficient technique that forces the SQL server process to access the GL file directly. If the FDM application path is not stored on the data server, the Windows account running the MSSQLServer Windows or Oracle service must have read access to the FDM Inbox folder.

5 Select the Database tab, and on OLE DB Provider, select ORACLED.Oracle (Oracle), SQLOLEDB (SQL Server OLE DB), SQLNCLI (SQL Server 2005), or SQLNCLI10 (SQL 2008 and 2008 R2).
Optional: If using Oracle, to override the default tablespace settings:

a. Click Options.

b. Select the preferred settings.

c. Click OK to return to the Database tab.

Click OK.

Configuring FDM for Oracle

For Oracle setup, on the Database tab, you must complete these fields:

- Service (Oracle service for connecting to the Oracle database)
- Database Name (name of the database that will be created)
- User name (database user name)
- Password (database password)

If Use Windows Integrated Security is selected, when FDM is accessed from the Web, the FDM application server account is used to log on to the Oracle Server database. When FDM is accessed from Workbench, the account used to log on to Workbench is used to log on to the Oracle Server database.

If Use Windows Integrated Security is not selected, you must enter a valid Oracle account. When you create an FDM database, the account used to log on to the Oracle database must either be granted the DBA role or have the following system privileges: Create Procedure, Create Sequence, Create Session, Create Table, Create Trigger, Create View, and Query Rewrite.
Single-Width and Double-Width Equivalents in Oracle DB

When using Oracle DB, single-width and double-width equivalents are treated as distinct strings instead of duplicate records. Consider this across the product.

Configuring FDM for SQL Server

For SQL Server setup, on the Database tab, you must complete the following fields:

Note: The following configuration applies to both SQLOLEDB and SQLNCLI.

- Database Server (domain name, IP address, or computer name)
- Database Name (name of the database that will be created)
- User name (database user name)
- Password (database password)

If Use Windows Integrated Security is selected, when FDM is accessed from the Web, the FDM application server account is used to log on to the SQL Server database. When FDM is accessed from Workbench, the account used to log on to Workbench is used to log on to the SQL Server database.

If Use Windows Integrated Security is not selected, you must enter a SQL Server account. When you create an FDM database, the account used to log on to the SQL Server database must be a SQL Server system administrator or have database creator rights and bulk insert administrator rights. After the database is created, the account can be limited to bulk insert administrator rights and db_owner rights.

Importing Standard Reports

After FDM is installed, the standard reports file (FinancialDataManagement-Reports111211.zip) is located in the <Oracle Home>/Middleware/EPMSys11R1/products/FinancialDataQuality/SharedComponents directory. The ZIP file contains the following:

- StandardReportsOracle1112100Active.xml—For use with Oracle databases and the Active Reports viewer
- StandardReportsSQLServer1112100Active.xml—For use with SQL databases and the Active Reports viewer

➢ To import standard reports:

1 Extract the desired file (StandardReportsOracle1112100Active.xml or StandardReportsSQLServer1112100Active.xml) into <application name>/templates.
2 From the Workbench desktop, select the Reports tab.
3 Select File > Import to open the Open Import File dialog box.
4 Locate and select the standard reports XML file and click Open.
5 On the Import dialog box, select the General tab and then the Reports folder.
6 On the Options tab, check Save Existing Machine Profiles to disable the machine profile override, or clear Save Existing Machine Profiles to enable the machine profile override.
7 If you want to save a custom report group, ensure that Remove All Report Groups on the Options tab is clear.
   If the option is checked, existing report groups are deleted before the application is updated with new reports.
8 Click OK.
   The Reports directory is displayed on the Reports tab.

Copying Standard Templates

After FDM is installed, the standard templates file (FinancialDataManagement-Templates11121.zip) is located in <Oracle Home>/Middleware/EPMSytem11R1/products/FinancialDataQuality/SharedComponents.

To copy standard templates:
1 Extract the ZIP file into <application name>/Outbox/Templates.
2 Verify that the templates were installed:
   a. Launch the FDM Web client by using the URL http://<WebServerName>/HyperionFDM.

      Note: If you are using a nonstandard port for IIS, you must include the port number in the aforementioned URL.

   b. On the Logon page, select your application and enter a user name, password, and domain (if necessary) to log on.

      Note: The default administrator account of a new application is the user name and password entered to create the application.

   c. From the FDM desktop, select Tools > Templates.
      In the right pane of the Tools screen, templates are listed as links.

Integration Requirements

To enable a new FDM application to interact with the Hyperion target application (Hyperion Enterprise, Planning, or Essbase) the corresponding adapter must be installed and configured.
See Chapter 9, “Configuring Adapters” for detailed instructions on adapter installation and setup.
In This Chapter

- About Adapters ............................................................................................. 37
- About Integration with Target Applications .............................................................. 38
- Integrating with Target Applications ...................................................................... 39

About Adapters

Adapters are predefined software codes that communicate with various target applications. Each adapter is programmed to integrate one specific source (for example, SAP or SQL) or target (Financial Management, Hyperion Enterprise, and so on) system. Adapters are composed of two components—DLL/EXE and XML metadata. DLL/EXE files contain the system-specific instructions for interacting with target or source systems. The XML files contain all data that relates to the current FDM application.

DLL/EXE

DLL/EXE acts as a buffer between an FDM application and a target application. DLL/EXE files contain the instructions that enable FDM to communicate with specified target or source applications (connecting to the database, loading data, extracting data, and so on). Each DLL file contains the API calls for a specific target or source application, thus enabling a FDM application to be flexible, to integrate with many target systems, and to not have to maintain numerous application-specific calls within itself.

XML Metadata

XML metadata acts as a second layer between an FDM application and its target applications. XML files store application setup parameters (setup options) and scripts to call API functions and return results from target applications.

XML metadata consists of the following components:

- Dimensions
- Actions
- Machine Profile
- Options
Dimensions

The dimensions section contains all available dimension lists for the target application. Each item of the primary dimension section represents one available dimension and contains a script that retrieves a list of all members of the dimension from the target application. The member lists are provided to FDM. Dimensions are included only in target adapters, not in source adapters.

Actions

Scripts interact with target applications and use adapter DLL API calls to perform such functions as Connect, Load, ValueGet, and Export.

Machine Profile

The machine profile contains the information required to enable FDM to determine on which servers source and target databases are located. The machine profile also stores global logon information for connecting to the target application.

Note: When Global Login is selected, FDM uses the global login user name and password to log on to target applications. Therefore, the global login user account must have access to the target application servers and security privileges within the target applications that enable FDM to load and retrieve values to and from the target applications, regardless of the user who is logged into FDM.

A machine profile must be configured for every computer that has FDM Application Server or FDM Task Manager installed, and for any machine running the Workbench client. However, only the following fields must be completed:

- Target Machine
- Source Machine
- Domain (Domain may be entered as NA if you are not using the global login ID)

Options

The Options section contains the default options for the FDM integration and application settings for the target application. Options modified within FDM are stored in the Options section.

About Integration with Target Applications

Integration settings are used to point FDM applications to target applications. The target application is the application where data is loaded. Hyperion Enterprise; Essbase; Oracle
Hyperion Planning, Fusion Edition; and Financial Management are examples of valid target applications.

One FDM application can load to unlimited target applications. For example, some locations in the FDM application can load to Hyperion Enterprise, while other locations load to Financial Management. In addition, the FDM application can be configured to load to multiple applications of one product (two or three Essbase applications, for example).

**Integrating with Target Applications**

Integration Tasks:

1. From FDM Workbench, log on to the FDM application.
2. Import the target system adapter.
3. Register the adapter.
4. Add a machine profile.
5. Update DCOM launching user rights (Hyperion Enterprise and Essbase only).
6. Map FDM dimensions to target dimensions (Financial Management and Essbase only).
7. Using Web Client, log on to the FDM application.
8. Verify the application settings.
9. Update the integration settings.
10. Test the integration settings.

*Note:* You must create an FDM application before you proceed with the procedures outlined in this chapter. See Chapter 8, “Setting Up FDM Applications” for instructions.

**Logging on to FDM applications**

➢ To log on FDM applications:

1. Launch FDM Workbench by selecting **Programs > Oracle EPM System > Financial Data Quality Management > Workbench > Workbench Client.**

   *Note:* You must have local administrator rights on the computer where Workbench is installed.

2. Log on to the application by using the same user name and password that you used to create the application.
Importing Target System and Source System Adapters

See individual adapter readme documents for detailed information on importing, registering, and configuring adapters. The FDM Adapter Suite is available on the Oracle E-Delivery Web site. The adapter readme documents are available on the Oracle Technology Network Web site.

Adding Machine Profiles

A machine profile must be configured for every computer that has FDM Application Server or FDM Task Manager installed, and for any machine running the Workbench client.

To add machine profiles:

1. On the Adapters tab, expand the Target System Adapters directory and the Expand Directory icon of the preferred adapter.
2. Right-click Machine Profiles, and then select Add Machine Profile.
3. In the Add Machine Profile dialog box, enter the required information:
   - Source Machine Name—The FDM application server name
   - Target Machine Name—The computer name or IP address of the application server or application cluster
4. Optional: To override the logon method specified by the integration settings, for UserName, Password, and Domain, specify a user name, password, and domain for the local computer.
   This option is generally not used; the unified logon functionality provided within FDM, which provides network authentication, is the preferred method. The local computer uses the specified user name and password to log on to the target application server and the application. The user account specified must have access to the target application server and appropriate security privileges, regardless of the user who is logged on to FDM.
5. Click OK.

Updating DCOM Settings (Hyperion Enterprise and Essbase)

The .clsHypWindow object (Hyperion Enterprise) and the .clsHypWindowEB object (Essbase) must be configured to enable access by the user name that is configured in the application servers.

To configure Windows objects:

1. From the Run command, launch dcomcnfg.
2. Right-click ups<adapter file name>.clsHypWindow, or ups<adapter file name>.clsHypWindowEB and then select Properties.

   Note: Examples of adapter file names are upsIntBlockEB7XA.clsHypWindowEB, upsIntBlockHE6xG.clsHypWindow, and upsES11XG4G.clsHypWindowEB.
3. From the Properties window, select the Security tab, and then click Edit.
4 For Launch/Activation permissions and Access, change the DCOM security settings to Custom.

5 Click Edit, and ensure that the user name running the application servers is added to the permissions.

![Image of Change Configuration Permission dialog box]

Note: The user names of all users who run Workbench must be configured in this manner.

Mapping FDM Dimensions to Target Dimensions (Financial Management and Essbase only)

For the drill-through feature to work correctly from Financial Management and Essbase, the FDM dimension must be mapped to the target dimensions.

To map FDM dimensions to Financial Management dimensions:

1 In FDM Workbench, open an FDM application.

2 Select the Adapters tab.

3 Expand the Financial Management adapter.

4 Right-click the dimension to map and click Properties.

5 On the dimension properties dialog box, in the Alias field, enter the name of the corresponding Oracle Hyperion Financial Management, Fusion Edition dimension.

6 Click OK.

7 Repeat steps 4 through 6 for active dimensions.
To map FDM dimensions to Essbase dimensions:

1. Open the Essbase outline and FDM Workbench side-by-side.

2. Right-click an FDM dimension and select Properties.

3. In the Properties dialog box, for Foreign Name and Alias, update the entries to reflect the associated Oracle Essbase dimension name.

Logging on FDM Applications by Using the Web Client

To log on FDM applications using the Web client:

1. Launch the FDM web client by selecting Start > Programs > Oracle EPM System > Financial Data Quality Management > Web Server Components > Web Logon.

2. Enter the user name and password that you used to create the application.

3. Click Logon.

Verifying Application Settings

To verify application settings:

1. From the FDM Web client desktop, select the Administration tab (left menu pane).

2. Click the Application Settings link to switch to the Application Settings screen.

3. From Options, select System Code.

   The system code should contain the name of the adapter that was added. From the Code field, any adapter that exists in the application can be selected.

4. Click Save.
Updating Integration Settings

To update integration settings:

1. Select Administration > Integration Settings to display the Integration Settings screen.
2. From Options, select Application Name.
3. Enter the name of the target application.
4. Click Save.

Setting the Logon Method

This option controls the method that FDM uses to log on to the target system when making a connection.

To set the logon method:

1. From the Web Client desktop, select Administration > Integration Settings.
2. On the Integration Settings screen, from Options, select Logon Method, and then select a method:
   - Unified—The FDM user name and password are used to log on to the target system. For this option to be usable, the target user name and password and the FDM user name and password must match.
   - Global—The user name and password specified for global logon is passed to the target system. With this option, all users use the same user name and password to connect to the target system.
3. Click Save.

Note: If a machine-specific user name and password is specified in FDM Workbench, it overrides the logon method specified here for the current computer.

Using the Global Logon Information Method

This option is used with the Logon Method option. If Logon Method is set to Global, use this option to set the user name and password used to log on to the target system. Separate the user name and password with a semicolon (user name;Password).

Testing the Integration Settings

To test integration settings:

1. From the Web client, select Activities > Maps.
2. Click Add.
   - A row is added to the grid.
3 Click **Browse for Target Value** to display the list of target accounts.

If the integration settings are configured correctly, a window is displayed with the list of accounts.

**Tip:** If the adapter has not been registered correctly, you will receive an error when browsing for target values.

**From the FDM Web Client**

If the settings are correct, the target members are displayed.
**Copying Adapters**

One FDM application enables you to load to unlimited target applications. When loading to multiple target system applications, add adapters by repeating the integration procedures.

If multiple target applications of one product are being loaded, you must configure additional adapters. Although the adapters are identical, each is configured for its specific target application. You can copy adapters from within Workbench and integrate the copied adapters with other applications that use the target system of the original adapters.

➤ To copy adapters:

1. From Workbench, select the **Adapters** tab.
2. Right-click an adapter, and select **Copy**.
3. Enter a new name for the adapter.

   **Note:** The name of a copied source adapter must include the source name. For example, “ERPI_2,” “EBS_Copy,” and so on. Otherwise, drilling through to the source will not work.

4. Click **OK**.

The new adapter retains the attributes of the original adapter. You need not add a machine profile or register the adapter.
Upgrading FDM

In This Chapter

- Updating Schemas ................................................................. 48
- Migrating Users to Shared Services ........................................ 49
- Updating Scripts .................................................................. 51

This chapter applies only when upgrading from an earlier release of FDM (11.1.1.3 or earlier). If you are performing a new installation or applying a maintenance release (FDM Release 11.1.2 to 11.1.2.1) use the Table 1, “FDM Installation and Maintenance Release Checklist,” on page 7. Perform the steps in the following table when installing an upgrade.

**Note:** When you apply the maintenance release to move from FDM Release 11.1.2.0 to Release 11.1.2.1, you also use the Schema Updater Utility to upgrade applications.

<table>
<thead>
<tr>
<th>Table 2</th>
<th>FDM Upgrade Checklist</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
<td><strong>Task</strong></td>
</tr>
<tr>
<td>3</td>
<td>Configure FDM using EPM System Configurator</td>
</tr>
<tr>
<td>Step</td>
<td>Task</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td>Configure Task Manager</td>
</tr>
<tr>
<td>6</td>
<td>Configure Application Server components</td>
</tr>
<tr>
<td>7</td>
<td>Configure Load Balance Manager</td>
</tr>
<tr>
<td>8</td>
<td>Configure Workbench</td>
</tr>
<tr>
<td>9</td>
<td>Upgrade existing FDM Applications using the Schema Updater</td>
</tr>
<tr>
<td>10</td>
<td>Upgrade users using the User Migration Utility</td>
</tr>
<tr>
<td>11</td>
<td>Update scripts</td>
</tr>
<tr>
<td>12</td>
<td>Configure adapter(s)</td>
</tr>
</tbody>
</table>

**Updating Schemas**

FDM Schema Updater is used to upgrade all earlier releases of FDM applications (including maintenance releases) to the current release.

➢ **To use Schema Updater:**

1. **Launch Schema Updater by selecting Programs > Oracle EPM System > Financial Data Quality Management > Workbench > Schema Update.**

   Schema updater displays the current schema level of the application for which you are logged on.

2. **Click Run to update to the current schema level.**

**Note:** Schema Updater does not update scripts. Scripts must be updated manually.

**Note:** Because Microsoft Excel is a required third-party component of FDM, the Schema Updater utility fails when Excel is not installed on the FDM server.
Migrating Users to Shared Services

Note: Except when integrating with Oracle's Hyperion® Enterprise® and using script-based authentication, Shared Services is required.

If you are upgrading from a release of FDM in which you did not use Shared Services for user authentication, run the User Migration Utility to upgrade FDM users to Shared Services. If you are updating from a release of FDM in which you did use Shared Services for user authentication, this process is not required.

Note: You must be logged in as a Shared Services administrator to use this utility.

Note: Shared Services must be enabled before running the User Migration Utility. See “Enabling Shared Services” on page 26.

To provision current users in an FDM application to Shared Services:

1. Start the FDM User Migration utility by selecting Start > Programs > Oracle EPM System > Financial Data Quality Management > Workbench > User Migration from the Windows Start menu.

2. On the FDM logon screen, log on to the FDM application in which to upgrade users. This user should be an administrative user in FDM.

   The FDM-User Migration window is displayed and lists all of the users associated with the FDM application.

   Email addresses for users shown in this window are for display purposes only. Email addresses are not migrated, synchronized, or provisioned in Shared Services for the selected users.

3. Select an application group.

4. Select individual user names or select All Users to select the users to provision in Shared Services by checking the box to the left of the user name.

5. Click Provision User(s).

   When the migration is complete, the status for each user selected changes to Provisioned.

6. Exit the User Migration utility.

7. Repeat the above process for each FDM application for which you want to perform user migration.

Note: For the users to be provisioned using User Migration Utility, the users that exist in the FDM application must exist in Shared Services as part of a provider or as a native user.
Troubleshooting Provisioning

Problem: You cannot log on to FDM using new user account because of the following error: “An error occurred logging on to the system. You do not have access to the application!” This error is caused by not properly provisioning a user to use FDM.

Solution: Use the following procedure to provision the user.

Note: The following procedure assumes the user that you are provisioning already exists in Shared Services. To add a user to Shared Services, see Appendix M of the EPM Security Administration Guide.

To provision a user to use FDM:

1. From the Windows Start Menu, select Programs > Oracle EPM System > Foundation Services > Shared Services URL.
2. On the Shared Services Login page, log on to Shared Services using an administrator account.
3. Expand the User directory and click Users.
   The list of Shared Services users is displayed. The location of Users is dependent on your particular Shared Services directory setup.
4. Right-click the user and select Provision.
5. On the Provision screen, select the appropriate FDM role for each FDM application as required.
6. Click the Add arrow (--> ) to add the roles to the Selected Roles column.
7. Click Save.
8. Log on to the FDM Web client.

   Note: When using Shared Services, the Security Level option on the User Maintenance screen in FDM is not selectable. Security levels must be set in Shared Services. After changing the security level for a user, changes take effect next time the user logs on to FDM.

    The New User dialog box is displayed.
11. In the Username list, select the user you provisioned in Oracle's Hyperion® Shared Services.
12. Click OK.
13. On the New User screen, under Locations, assign a default location (or all locations) for the new user.
14. Click Update Grid.
15. Click OK.
Updating Scripts

**Note:** The information in this section only applies when upgrading from FDM Release 9.3.x or earlier.

FDM release 11.1.2.1 includes scripts that were not included in 9.3.x releases of FDM. The file `DBSetup.zip` contains the scripts and is included in the following directory:

`Shared Components.<Oracle Home>/Middleware/EPMSysmm11R1/products/FinancialDataQuality/SharedComponents/`

Unzip `DBSetup.zip` to the scripts directory

`<Oracle Home>/Middleware/EPMSysmm11R1/products/FinancialDataQuality/Data/Scripts/Custom/`
The information in this chapter applies only to localized releases of FDM. The list of supported languages for all Oracle Hyperion Enterprise Performance Management System products is included in Oracle Hyperion Enterprise Management System Installation Start Here. The list of supported languages for this version of FDM is included in the FDM Readme.

**Regional and Browser Settings**

When logging on to the FDM Web server, the language that appears within parts of the user interface (UI) depends on several settings, and may appear differently depending on language settings of the FDM database server, operating system, FDM user settings, and local computer language settings.
<table>
<thead>
<tr>
<th>UI Element</th>
<th>Latin-Based Languages</th>
<th>Asian Languages (exclusions)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Web</td>
<td>Workbench</td>
</tr>
<tr>
<td>Login Page</td>
<td>IE</td>
<td>OS</td>
</tr>
<tr>
<td>All other web pages</td>
<td>DB</td>
<td>NA</td>
</tr>
<tr>
<td>Error Log Dates</td>
<td>ISO</td>
<td>ISO</td>
</tr>
<tr>
<td>Error Log Content - FDM/FDM Adapter Errors</td>
<td>DB</td>
<td>DB</td>
</tr>
<tr>
<td>Error Log Content - VB Runtime</td>
<td>OS</td>
<td>OS</td>
</tr>
<tr>
<td>Error Log Content - Target System Errors</td>
<td>TS</td>
<td>TS</td>
</tr>
<tr>
<td>Reports (All English reports displayed, able to create language specific versions)</td>
<td>UD</td>
<td>UD</td>
</tr>
<tr>
<td>User (Application) Lock Message</td>
<td>UD</td>
<td>UD</td>
</tr>
<tr>
<td>POV Mode Lock Message</td>
<td>UD</td>
<td>UD</td>
</tr>
<tr>
<td>Object Maintenance - Keyed Fields</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Object Maintenance - Description/Tool Tips</td>
<td>DB/UE</td>
<td>NA</td>
</tr>
<tr>
<td>Option Settings – Content</td>
<td>DNT/UD</td>
<td>DNT/UD</td>
</tr>
<tr>
<td>Option Settings - Description &amp; Titles</td>
<td>DB</td>
<td>DB</td>
</tr>
<tr>
<td>User/Web Settings - Report Publish Type</td>
<td>DNT</td>
<td>NA</td>
</tr>
<tr>
<td>User/Web Settings - Status Bar Icons, Themes</td>
<td>UD</td>
<td>NA</td>
</tr>
<tr>
<td>Templates</td>
<td>UD</td>
<td>NA</td>
</tr>
<tr>
<td>Task flows – Task flows must be configured for each language</td>
<td>UD</td>
<td>NA</td>
</tr>
<tr>
<td>Dimension Key Names</td>
<td>DNT</td>
<td>DNT</td>
</tr>
<tr>
<td>Dimension Alias</td>
<td>UD</td>
<td>UD</td>
</tr>
<tr>
<td>User -Defined Metadata Names</td>
<td>UD</td>
<td>UD</td>
</tr>
<tr>
<td>Target System Lists (Member Lists)</td>
<td>TSD</td>
<td>TSD</td>
</tr>
<tr>
<td>Adapter Names</td>
<td>DNT</td>
<td>DNT</td>
</tr>
<tr>
<td>Import Format Expression Keys (Types)</td>
<td>DNT</td>
<td>NA</td>
</tr>
<tr>
<td>Validation Report Format Code Keys</td>
<td>DNT</td>
<td>NA</td>
</tr>
<tr>
<td>Scripts - VB Code Inside Scripts</td>
<td>DNT</td>
<td>DNT</td>
</tr>
<tr>
<td>Workbench Load Balance Server Groups</td>
<td>NA</td>
<td>OS</td>
</tr>
</tbody>
</table>
### UI Element

<table>
<thead>
<tr>
<th>Location Risk Level/Question Risk Level</th>
<th>Latin-Based Languages</th>
<th>Asian Languages (exclusions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web</td>
<td>Workbench</td>
<td>Web</td>
</tr>
<tr>
<td>Acronyms and Abbreviations</td>
<td></td>
<td>DB</td>
</tr>
<tr>
<td>Control Question Attributes (Types, Risk Freq)</td>
<td></td>
<td>DB</td>
</tr>
<tr>
<td>Currency Code Acronyms</td>
<td></td>
<td>DNT</td>
</tr>
<tr>
<td>Memo, Red Flag, &amp; Audit Memo Column Headings (I, G, E)</td>
<td></td>
<td>DB</td>
</tr>
<tr>
<td>Activity Log types - OK/Err</td>
<td></td>
<td>DNT</td>
</tr>
</tbody>
</table>

### Control Limitations

<table>
<thead>
<tr>
<th>Browse buttons</th>
<th>OS</th>
<th>OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK/Cancel (from Message Boxes)</td>
<td>OS</td>
<td>OS</td>
</tr>
<tr>
<td>OS Common Dialogs (File Browse, and so on)</td>
<td>OS</td>
<td>OS</td>
</tr>
<tr>
<td>FDM Object Browser – Titles</td>
<td>DNT</td>
<td>OS</td>
</tr>
<tr>
<td>FDM Object Browser – Content (API-based)</td>
<td>DNT</td>
<td>DNT</td>
</tr>
<tr>
<td>Active Reports Designer</td>
<td>NA</td>
<td>DNT</td>
</tr>
<tr>
<td>Active Reports Viewer</td>
<td>NA</td>
<td>DNT</td>
</tr>
</tbody>
</table>

### Utilities

| Config Utilities, Installer           | NA         | DNT        |
| Task Manager                          | NA         | OS         |
| User Migration                        | NA         | DNT        |
| Schema Updater                        | NA         | DNT        |

### Key:
- IE-Internet Explorer; OS-Operating system; DB-User setting stored in FDM database; NA-Not applicable; ISO-International Standard Format; UD-User defined (global). Translation is customer-driven, one description for all languages; UE-User editable; DNT-Does not translate (English only); TS-Based on language of target system installed; TSD-Target system dependent. List provided by other Hyperion products (not FDM).

## Changing Preferences

1. To change the default language settings for FDM:
2. Log on to the FDM Web client
3 On the Web Settings screen, from Select your default Language, select the default language for FDM to display.

4 Click Save.

**Note:** The default language setting is the language that will be displayed for all new users.

To change the language settings for individual users in FDM:

1 Log on to the FDM Web client.

2 Select Tools > User Settings.

3 On the User Settings screen, from Language, select the language for FDM to display.

4 Click Save.

**Decimal Replace on Database Setup**

Because FDM supports language localization and regional date, time, and number formats, you must ensure that decimal formatted-related options are set. Two precepts govern decimal handling in FDM:

1. The selected locale for standards and formats on the FDM application servers determines the characters designated as the thousands and decimal separators. This setting affects decimal-formatted data in imported data files, as well as the default decimal format used to create export files and to load target systems. Locale setting is accessed from Regional and Language Options in the Windows Control Panel.

2. The DBMS that serves as the FDM repository always requires that decimal data be formatted without a thousands separator, and the decimal separators are periods.

The implications of precept No. 1 are that you must take additional steps when the application server decimal format differs from the import data file decimal format (or from the format expected by the target system).

For example, if an import file with English-formatted decimals is imported into FDM running on a French-locale application server, you must use an import script or the Fill=UsToEuro expression to convert the decimals to the French format (decimal separator is a comma). Also, to export from the French-locale application server and load a target system that expects English-formatted decimals, either the target system must implement its own conversion mechanism, or an FDM script must be used to perform the output conversion before sending it to the target system.

The implications of precept No. 2 are that whenever the FDM application server decimal format specifies any character other than a period as the decimal separator, you must set the decimal replacement option (found in FDM under Administration > Configuration Options) to ensure that the comma, or other character, is converted to a period before data loading.
Date Formatting on Midtier Items

Dates for midtier items are represented in ISO format (yyyy-mm-dd). Examples of midtier items include error logs and processing logs. The date format is set by the operating system and is displayed in the short date format. This setting is in the regional settings applet in the control panel. This setting only affects entering the period key and the formatting of the period text description.

Non-English User Settings

The Application Setting Option values are not translated and appear in English regardless of the language setting.

Schema Updater Logs

Any time a schema updater is run, FDM writes to the Schema Updater log. This log is used by Oracle technical support personnel for troubleshooting. Therefore, this log is always compiled in English, regardless of the local OS version, OS regional settings, or FDM language settings.

Multibyte-Compatible Font Names in Report Designer

When working in the Reports Designer, multibyte-compatible font names may not display correctly in the Formatting Toolbar or the Property Toolbox.

To modify reports to use multibyte-compatible fonts:

1. Use FDM Workbench to log in to an application.
2. Select the Reports tab.
3. From the list of reports displayed in the left pane, right-click a report and select Design Report.
4. In Report Designer, select a field in which to change the font.
5. In the Property Toolbox, click the Font ellipsis icon (…).
6. In the Font dialog box, perform the following actions:
   a. In the Font field, select a multibyte-compatible font.
      For example, on a Japanese OS, MS Mincho and MS Gothic fonts are multibyte compatible.
   b. In the Script field, select a script type. The script type controls the character set that is supported.
      Depending on your current language settings and operating system version, the “Script” field may be displayed as “Character Set.”
   c. Click OK to close the Font dialog box.
After completing Step 6, the default character set value of zero (0) in the Style field of the Property Toolbox should be set to the appropriate value. For example, for Japanese, the field may read font-family: '&<font specified in step 6a>''; ddo-char-set: 128; font-size: 15.75pt; font-weight: bold; color: rgb(0,0,128);

7 Repeat steps 4 through 6 for all other fields in the report.

8 Click Save in the upper-right corner of the report designer.

**Note:** The Font and Character Set values must be modified to run the reports whenever the required characters are not supported by the default values provided.

**Note:** Multibyte-compatible font names do not display correctly in the Formatting Toolbar or the Property Toolbox. The font names do display correctly in the Font dialog box (step 6).
Database Server

Database server topics:

- Recommended hardware
- Database sizing

**Recommended Hardware**

- One quad P4 processor
- 1 GB RAM per 75 concurrent users (2 GB minimum)

Selecting the appropriate data server hardware is critical for optimal performance of FDM applications. If database servers are not properly sized, their operation can become problematic. Adding more application servers and improving performance for selected tasks may quickly overwhelm the database server.

**Database Sizing**

- The average total disk space required per location equals .526 GB per month (based on an average file size of 95 MB and the use of three custom dimensions). Each additional dimension increases the estimate by approximately .025 GB.

**Note:** Average disk size recommendations should be adjusted based on the estimated average size of the files to be loaded and the number of custom dimensions to be used.
For Oracle, each tablespace (Work, Index, Map Seg, and Data Seg) should be on a separate drive. For SQL, the database file and log file should be on separate physical drives.

For improved performance, use the fastest drive available.

Document attachments affect total disk space. Each attached document is archived in the application file structure and occupies the same disk space as the original file.

Exported archive files affect total disk space. Each exported archive resides in the Archive Restore directory and occupies the same disk space as the original archive.

**Application Server Recommended Hardware**

- One dual P4 processor per 75 concurrent users
- 1 GB RAM per 75 concurrent users

**Web Server**

These following are the topics related to the Web server:

- Recommended Hardware
- .NET Process Configuration
- Memory Recycling

**Recommended Hardware**

- One dual P4 processor per 100 concurrent users
- 2 GB RAM

**.NET Process Configuration**

In the `Machine.Config` file:

- Increase MaxWorkerThreads to 100.
- Increase MaxIOTThreads to 100.

**Memory Recycling**

- By default, FDM 9.0.2 and later use IIS memory recycling to force the Microsoft.NET process to recycle memory when the process reaches 250 MB (Windows 2003). These values are based on a Web Server running 2 GB of RAM. For servers running 4 GB of RAM, adjust the settings to 15–200 MB (Windows 2003). For servers with 4 GB or more of RAM, it is extremely important that the default memory limit be adjusted.
By default, FDM 9.x use aspnet_state service to store session values while the IIS memory recycling process is running. The service must be running on the Web Server for FDM to operate correctly.

**Application Settings**

You can update FDM data segments in the FDM configuration options before creating FDM locations. The data segments represent the number of data tables within the FDM application. The data tables are shared by the data load locations. To avoid data locking, 5–8 concurrent data loaders per segment are needed (for example, 600 concurrent data loaders in one FDM application results in 75–120 data segments).

*Note:* This setting applies for each Oracle Hyperion Financial Data Quality Management, Fusion Edition application.

**Firewall/DCOM Settings**

- Port 135 must be open on all application servers and Web servers to allow two-way DCOM communication.

- Unlike most Internet applications which have fixed TCP and/or UDP ports, DCOM dynamically assigns—at runtime—one TCP port and one UDP port to each executable process serving DCOM objects on a computer. DCOM, by default, is free to use any port between 1024 and 65535 when it dynamically selects a port for an application, but configuring your firewall to leave such a wide range of ports presents a potential security risk. You may change the following registry to decrease the open DCOM port range:
  
  ```
  HKEY_LOCAL_MACHINE/Software/Microsoft/Rpc/Internet
  ```

  Details on restricting DCOM ports can be found in the Microsoft knowledge base article:

  http://support.microsoft.com/kb/154596

  For details about other firewall issues, see the Microsoft knowledge base article:


**TCP Keep Alive Settings**

Keep Alive settings determine how often TCP sends keep-alive transmissions. TCP sends Keep Alive transmissions to verify that an idle connection is still active. Oracle recommends that you reduce this setting to 30 minutes. For details on updating the KeepAlive settings, see the Microsoft knowledge base article: